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1-INTRODUCTION

1.1 Foreword

In the period since the release of EZdrummer in April 2006, many Superior users have
requested MIDI functionality to expand the scope of their favourite drum sampler.
EZdrummer users have also expressed a desire for functionality that goes beyond any
developers current offering in terms of MIDI triggering management.

After much discussion on how to best achieve this goal, we set out to create what can
be best described as the Swiss Army knife of drum samplers.The EZplayer concept
was born.

EZplayer pro was thus designed with Toontrack customers in mind first, but also for
anyone with more than one drum sampler in their arsenal and the specific need to
convert between various sources of MIDI, complete with their idiosyncrasies. We
also mean to address the legions of songwriters out there who find the unnecessary
complexity of sequencing environments at their disposal uninspiring.

This is, quite obviously, an ambitious project. Both versions of EZplayer mark a new
beginning for Toontrack Music in terms of developing products intended to enhance
the functionality and usefulness of our core sampler lines in a way that plugs right
in your workflow. We are therefore extremely proud to introduce EZplayer pro,a
powerful MIDI organizer and songwriter friendly arranger, recorder and jammer.

We would like to thank all Toontrack customers for their loyalty and support in the

5 years of Superior and EZdrummer development, and would like to thank new users
for their interest in EZplayer which we are confident is an introduction in style to our
product line.

The Development Team

@TOONTRACK MUSIC
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1.2 What is EZplayer?

EZplayer is a MIDI organizer capable of driving any sound source that can be
controlled by MIDI, including software drum samplers such as Toontrack Superior
and EZdrummer but also any hardware drum machine you may have available. All it
requires is a module (software or hardware instrument) capable of producing sounds
from MIDI.

But this is not the sole purpose of this product. Not only can you organize and preview
your MIDI library, no matter the content provider, but you can also construct a drum
track in minutes by arranging grooves on the time line, directly in your sequencer’s
arrangement window!

EZplayer pro goes way beyond these solid foundations however and allows you to
arrange, edit and trigger your grooves (and licks) in ways you may have never imagined
were possible before, right inside the program, thanks to an intuitive built-in arranger.
You can control your drum parts live down to their very heart-beat and dynamics and
randomize your parts at every pass if you want to. You can transpose your licks and
create polyrhythms effortlessly if that’s what you're into. The sky really IS the limit!

This documentation assumes basic knowledge of operating your sequencer program
and Your Favorite Drum Sampler (referred to in the rest of this manual as YFDS). It

is imperative that you have a good grasp of MIDI routing as EZpl/ayer, while a simple
product in operation, relies on the host capabilities to provide the appropriate bridging
between EZplayer and YFDS.

We have included instructions as detailed as possible for the major host programs
available on the market, but your program’s User Manual should be your first port of
call if you experience difficulties implementing the required MIDI routing.

If you require further help, Toontrack advisers as well as seasoned users will be happy
to assist via the dedicated forum at http://www.toontrack.com/forum/ and of course
email support is available for all registered users at http://www.toontrack.com/support/
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2 - INSTALLATION ———

2.1 System Requirements*

* Windows Vista or newer, Pentium IV / Athlon 1,8 GHz with 512MB RAM
(32 and 64-bit versions of Windows are supported as per host application)
* Mac OS X 10.5 or higher, G5 or Intel processor with 512MB RAM
(32 and 64-bit hosts are supported on the Mac Intel platform)
* A virtual drum sampler; hardware drum machine or MIDI capable sound module.

Recommended:

* Display capable of 1024x768
* A software sequencer or virtual instrument host
* sound card with ASIO or CoreAudio driver

* the system requirements presented here may not meet your virtual sampler or
hardware module requirements. Please refer to the relevant user’s manual for details.

2.2 Installing EZplayer for Windows

Run the included EZplayer Installer and follow the instructions. Please ensure you are
logged in as an Administrator and have no User Access Control restrictions enabled
before proceeding (see your operating system’s help files for details).

The plugin will be installed by default in the appropriate location for the currently
installed host program.You should however verify that this is the case and perform

a custom install to change the destination target if this is not adequate for your host
program (see your host’s manual for default plugin location).

To uninstall simply re-run the installer or use your operating system’s removal facility.

2.3 Installing EZplayer for Macintosh

Run the included EZplayer Installer and follow the instructions. Please ensure you are
logged in as an Administrator before proceeding.

The plugin will be installed in the default location for your operating system and should
not be moved to remain available to all users and programs.

To uninstall simply run the EZplayer Uninstaller provided and select the components
you wish to remove.

EZplayer
8



2.4 Authorizing EZplayer on your computer

The first time you access EZplayer pro from within your host program, you will be
presented with the authorization screen. Simply follow the on-screen instructions:

AUTHORIZATION

EZplayer pro is not authorized to run on this computer!

Y| Copy or write down this Computer ID » [T\ VRI[N(«{T]=RT]]s}

2. Locate your serial number

3. Gotowww.toontrack. fregister and follow the instructions.

" Paste your authorization code here »

Here is an overview of the online process to assist you:

1) Should this be your first Toontrack product, create a new user account at
http://www.toontrack.com/ and follow the procedure outlined there.

2) Go to http://www.toontrack.com/register/ and log into your account.
Click ‘Register New Product’.

3) Enter the product serial number found on the packaging of the physical product
or included with your electronic receipt if this is a download purchase.

4) Type in the Computer ID exactly as shown in the program interface when
requested to do so and add a short description to help identify the computer.

5) Complete the process to obtain the Authorization Code. You will receive a
confirmation by email with all the relevant details for your records. Type in the
code or paste it in the box shown in green in the screenshot above.

You will be greeted with a congratulations message to confirm the product has been

authorized successfully.

Should Authorization fail, please first make sure the computer ID displayed in the
Authorization Screen indeed matches the one you used to generate your code.
Please also review the Authorization FAQ located at http://www.toontrack.com/faq/

If the problem remains unresolved after this, please contact support using the
above URL, making sure to include your serial number; Computer ID, and a detailed
description of the issue so our support advisers may help you as efficiently as posible.
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2.5 Adding MIDI content

For EZplayer to be of any use you will of course need MIDI files to browse and
organize.

We have included a variety of drum grooves to get you started. This collection was
specifically developed for Toontrack Music lines of drum samplers but can nonetheless
be used to trigger YFDS thanks to EZplayer’'s Map wrapping capabilities.

Adding content to EZplayer is extremely straightforward:

1) locate the MIDI files you would like to add on your hard drive or download them
from the Internet*

2) drag the folder directly inside the EZplayer User Interface.

3) in the ensuing dialogue, specify a name for the “mount point”

4) select the appropriate format (or ‘Thru’ if unavailable)

Alternatively you can select the ‘Add path’ entry in the top left corner Menu and
navigate your hard drive to the same effect. This latter method can be useful if your
operating system or host forbids direct drag and drop to EZplayer:

Note that you should ensure the anchor folders (the folders containing the MIDI
files) remain in their location once added to EZplayer. Do not rename or move

them on your hard drive. Their content, including subfolders can however be
rearranged at will at any time.

[Ties] You may remove or edit a browser entry by Right ¢ clicking / Control ™A€ clicking
it at any time. Double clicking it will reveal it in the Finder/Explorer.

EZplayer pro users should refer to chapter 6 for additional mount points properties
and their usage.

* Free content for all EZplayer customers is available by selecting ‘Download Free MIDI’
from the Help menu located in the top right corner of the interface.

The ‘Content Providers’ link will also give you instant access to hundreds of new MIDI
files to add to your EZplayer courtesy of Toontrack Music selected partners.
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3 - Quickstart Guide
3.1 Interface Overview

After inserting EZplayer into your host application (see Appendix section for help)
you will be presented with the User Interface as per the screenshot below:
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The EZplayer pro window is divided into two distinct sections, the Browser at the
top and the Arranger at the bottom.

You can toggle between hiding the Browser and displaying it by pressing the B button.
You can also drag between the two sections and adjust it to your preference:

EZplayer
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3.2 Selecting a sound source

It is very important to understand that EZplayer will not produce sound by
itself. Instead it will pass on MIDI information to the host, and the latter will take
care of routing it to YFDS (or hardware sound module) which will be solely providing

playback of this information.

Before you start working on that killer song of yours, you should therefore tell
EZplayer what sound source you will be using as well as route its output in an
appropriate manner in your host so that the MIDI bridge is functional. If you require
help setting up your host, see the appendix section at the back of this manual.

Once you have confirmed that the MIDI bridge is functional, click on the Map Wirap
dropdown menu just underneath the browser and select the appropriate format:

a = 3 7 = ]

MAP WRAP (Master) !'!..........................
B

v Follow Tracks

MIDI Output

Thru

Ceneral MIDI

Toontrack EZdrummer
Digidesign Percussionist
FXPansion Superior 1
Native Instruments Superior 2
Propellerhead

XLN Audio

If YFDS is set in your host to
receive MIDI on a particular
channel, as would be typical
in a multi-track environment,

MAP WRAP (Master)

Follow Tracks

[T

you should also force EZplayer [ MIDIOutput  » KL

to assign the MIDI information
to the relevant channel using
the MIDI Output selection:

Alternatively you can leave the Master Map Wrap at its default
and use the Arranger tracks equivalent to conveniently switch
between different sound sources when previewing your
grooves using the Browser (see Advanced section for details).

Channel 1

Channel 3
Channel 4
Channel 5
Channel 6
Channel 7
Channel 8
Channel 9
Channel 10
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3.3 Auditioning grooves

Once the connection to the desired sound source is established, finding the perfect
groove could not be any easier. Simply navigate the Browser to uncover the perfect
groove. Remember that what you are auditioning are MIDI files, not audio loops.

This means that at no point are you committing to the sound source currently chosen
to preview the groove. In addition a close match can always be edited to fit exactly
what you have in mind so there’s no need to waste more time than necessary trying to
find that perfect groove that you may or may not have in your library.

Still, with EZplayer it is so convenient to preview grooves that browsing the library
randomly may actually spark your inspiration. Press Play in EZplayer as well as your
sequencer and, you will be able to audition all your grooves in the context of the song,
at the right tempo!

You can even get instant access to half-time or double-time variations of the groove by
engaging the appropriate time factor: QEIECNEE

If you prefer to evaluate grooves suitability at a different tempo than the current
project (for example, because you just thought of a new riff there and then and now
want to jam) you can easily uncouple EZplayer from the host tempo by clicking (G
once and double clicking the bpm field to its left. Press it again to re-link playback to
the project tempo.

To round up the extensive previewing capabilities of EZplayer, it is also worth noting
that EZplayer lets you listen to any MIDI at the internal tempo of the file, usually
the tempo that best preserves the part’s original feel, swing and groove. Press the
button to enter this mode: = ne

[Trs] Right clicking P< / Control clicking "< a groove will toggle the Play button. In
addition to clicking on grooves while the Play button is engaged you can also use the
navigation controls situated to the left of the groove display, just below the Browser.

If you would rather listen to one groove at a time without repeating it over and
over again you may also double click its name and EZplayer will play it a single time
then stop. This can be invaluable to assess start and end points of a groove.

A position indicator is also provided to assist you in this process.

EZplayer
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3.4 Changing the dynamics

One aspect of EZplayer that we are sure you will come to love is the ability to adapt
the dynamics of a groove to fit the song and/or other grooves already selected for
inclusion in your song.

It is indeed unrealistic to expect all MIDI content to be calibrated against an elusive
reference so you will often come to a point where mixing grooves from library A with
library B will result in unnatural transitions.

Also, you may simply just want a particular groove to be a lot more subtle than originally
intended, or you may want to create a build-up by progressively tweaking the dynamics
of a fill you've constructed by placing multiple copies of a MIDI clip one after the other.

In all the above cases, simply twist the Velocity knob until the desired
effect is achieved, softer to the left and harder to the right.

3.5 Building a drum track

Once you have found a groove that you like, drag it into your host on the track
assigned to the relevant instrument.

It is as easy as that!

£ HATS CLOSED o
Fi

var

[Ties] You may also drag grooves from the Browser information panel to incorporate
the groove whose name is currently shown into your project.

Alternatively to dragging to your host you can explore EZplayer pro’s impressive
arranging and editing capabilities. The adventure starts in the next chapter!

EZplayer
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4. Fast Track Songwriting
4.1 The Multi-track Arranger
Up until now we have presented EZplayer as a tool designed to audition and manage

MIDI files but that’s just a small part of what it has to offer. Thanks to an intuitive
integrated MIDI arranger, EZplayer pro can be used as a powerful songwriting tool.

As already mentioned, the lower part of the EZplayer pro interface is called the
Arranger and is essentially a multi-track sequencer with arranging capabilities. To use
it you really do not need a lot of experience using what is commonly referred to as a
‘Digital Audio Workstation” or DAW.

With EZplayer pro all you need to know is that what you hear is what you get and
it doesn’t matter what happens behind the scene. No complicated MIDI knowledge
is required, you can get straight on with songwriting with no superfluous baggage
imposed by the software.

For example you can drag and drop different drum patterns from the Browser into

a track, then play them back in order, from start to finish. It really is that simple! You
can have as many tracks as you like, and you can create new ones easily, with unlimited
layers slaved to them if you want to. It really is that flexible!

You can audition any track on its own by pressing the Play
button next to it on the left hand side or you can play them
all at once by pressing the “Global Play” button located in the
bottom left corner of the interface. It’s so intuitive!

You can also get instant access to key track information by
holding down @ and changing the track’s settings from the
contextual menu [==|. It really is a new way to write songs!

EZplayer
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4.2 Tracks and layers

You can organize your arrangement using tracks and layers. Tracks are exactly what
you'd expect them to be,a component of the song allowing the musical arrangement
to evolve throughout the song. Layers can be thought of as alternative parts that you
can use in specific places or randomize at every pass.

Layers and their usage will be touched upon later on in this manual but for now let’s
describe the track controls in more detail to give you a comprehensive overview of
what you can do with them!

As mentioned in the previous paragraph tracks can be triggered independently from
one another using the “Track Play” buttons (or using an external controller, see
chapter 6 for details). Familiar controls such as ‘solo’ and ‘mute’ can obviously assist
you in arranging the sequences or “clips” on the timeline.

it's to fine tune the part using the editing tools available E E

in EZplayer pro or to lay as foundation for the song IEEEEESSE [ESEEEEE
Simply drag across the timeline above the clips you would like to repeat. To take the
track out of loop mode, Right P© / Control ™A€ click in the timeline or it to collapse.

You can also set loop points for each track to delimit
what portion of a track you would like repeated, whether

The great power of EZplayer pro is that each track can drive an instrument in your
host independently from any others. Just use a distinct M/D/ Output channel and
specify the appropriate mapping in the Track Map Wirap (refer to chapter 3, Selecting a
Sound Source for further details).

[Ties] Please assign a couple of tracks to different instruments in your host now to
ensure you understand the concept of routing to different MIDI channels.

Naming your tracks to help identify their content (such as “Shakers”), the instrument
they are intended for (say “EZdrummer”), or their role in your song (“‘bridge” or “fills”
for example), is time well spent. Click in the Track name field and type what you desire.

Once that is done, you will notice that if the Master Map Wrap just below the Browser
is set to its default of ‘Follow Tracks’ (set it now if that’s not already the case), the groove
highlighted in the Browser will automatically trigger the instrument assigned to the track
selected in the Arranger. This is a convenient way to choose your building blocks without
having to constantly switch channel and wrapper in the Master Map Wrap.

Staying on familiar territory, notice that every track has its own ‘velocity’ knob to allow
you to modify the track’s dynamics, again softer to the left, harder to the right.

EZplayer
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4.3 Accessing Kit Pieces

In addition to auditioning your MIDI files as indivisible parts, EZplayer pro can
intelligently extract and split percussive MIDI files into kit pieces for example to
separate kick, snare, hats from a groove or your bongos from your shakers.

This means that you can now, and for the first time, easily and effortlessly combine
elements from different MIDI files to form exciting new beats to add to your musical
creations. The possibilities are endless!

To access kit pieces, navigate your library to a groove that contains the ‘kit pieces’ that
you'd like to use.

Note that this feature is not restricted to the MIDI supplied with this product and
will work with any percussive MIDI files that you add as long as you select a source
mapping in the import dialogue (see chapter 5 for details).

ad

) PERCUSSIVE PATTERKS +

(=123 L

Once you have found parts that you would like to use in isolation or recombine to
form a new groove, simply drag them into your host or to the EZplayer pro Arranger.

[Ties] Multiple kit pieces can be selected by Option € clicking / Command MA clicking
them. Note that by default kit pieces are inserted on separate layers on the target
track in the Arranger: If you prefer them to be fused into a single part choose the
‘Merge Kit Pieces’ option from the Menu in the top left corner of the interface.

EZplayer
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4.4 Manipulating Clips

Moving and copying clips on the time line is straightforward. “Rubber band” select the
clips you want to relocate and drag them to the correct position. By holding down the
Control P¢ / Command MA€ key you can duplicate the clip(s).

Note that the above works for time shifting parts on a given track or to rearrange
clips between tracks. Just drag to a different track with the default ‘select’ tool “
to relocate them there.

To resize the beginning or the end of a groove use the ‘resize’ tool:
Note that if you resize beyond the clip’s original length the tool will automatically
behave like a repeater, before or after the original.

To delete a clip use the ‘Delete’ tool or Right "/ Control "< the clip and
select ‘delete’.

. e
If you want to undo or redo the changes you’ve made click and
respectively.

[Tes] When moving clips around, the default action is to replace clips g uzcnr
currently occupying the target location. By changing the Arranger mode
to ‘insert’ you can displace all clips (or sections of clips) to the right instead.

To split a clip at the point indicated by the playhead (the white line that moves around
the screen during playback), Right ™ / Control ™€ click the clip and select ‘Split at Playhead’.
To position the Playhead, click at the desired location in the track ruler just above the clips.
Double click this area to start playback.

By default, clips snap to beat positions to ensure your music stays in time. But you can
freely move the clips around by turning ‘Snap to Grid’ off in the track contextual menu.
We will cover grid options and track syncing in more details at the end of this chapter.

Clips can of course be renamed. Right ¢ / Control A€ the clip and select ‘Rename’ and
type in the new name in the ensuing dialogue. One nifty trick you will no doubt rely
heavily on is the library anchor shortcut that allows you to return to the original clip in the
Browser, be it to refer to the original groove or drag more copies of it (or the kit pieces
it is composed of): Just SHIFT click the clip to instantly reveal it in your library!

EZplayer
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4.5 Editing Clips

Editing clips in the Arranger can be performed in a number of useful and musical ways
to yield the exact pattern wanted.

Trying to edit your grooves to add accents or extra notes can be tricky some of the
time, especially if you have little experience programming drums. With EZplayer pro
however you can drop accents in with a simple click.

Just select the ‘Accent’ tool (click hold to select the type of accent desired) and
click on the clip and location you would like to accent. If you want to move the accent
to a different location at any point just drag it in time. To delete click on it with the
SHIFT key held down.

You can also transpose it later on, to repurpose it or try new things.As an example
you might want to create some tension with a well placed rim shot instead of a regular
snare hit. The accent definition is always available at the bottom of the Arranger.

For example a kick will always be on note 36*
regardless of the particular sampler currently
mapped to the track. Notice that the velocity
(hardness) of the accent can be modified
individually too.

But that’s not all! The ‘Transpose’ feature allows you to transpose not only accents but
also selected clips up or down. Great for changing the sound of a groove from one
drum to another. Experiment with kit pieces or complete grooves and you may find
some completely unexpected rhythms!

And the same goes for the velocity control. Remember when we introduced the
Browser in chapter 3 and suggested creating build-ups? Well here is your chance to
try it for yourself: drag a suitable one- or two- beats fill to a track and repeat it four
times with the ‘resize’ tool. Then select each copy one after the other and increase the
velocity slightly compared to the previous one.Terrific!

The last tool to introduce is ‘Time-Stretch’ tool:

Think of it as a similar control to the half time / double time buttons located
underneath the Browser except that you have complete control over the factorial
applied so you can not only ‘slow down’ or ‘speed up’ but also create compound
patterns effortlessly.

* A chart with common notes information can be found at the end of this manual
but quite obviously your ears will be the judge of what is musically interesting.
Learning the note correspondence is useful but is by no means a requirement.
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4.6 Grid Options and Track properties

Now is the perfect time to introduce the track’s ‘Time Signature’, located in the
bottom right hand corner of the EZplayer pro interface, which changes the time
signature for the individual track. That's right! You can have multiple time signatures in
the Arranger to create some interesting polyrhythms.

Regardless of time signature you will probably find it useful to have different grid
references for different tracks, in order to force notes to snap to a particular bar division.

The track’s properties can be defined by accessing its contextual menu:

Most of the options you can find here
are self-explanatory.

Edit Define the grid layout by selecting the
Sync to Tracks at appropriate value in the ‘Grid’ submenu.
Crid ‘Snap to Grid’ constrains the clips and
fenm accents to the chosen grid resolution.
S Add, copy, cut and paste between
tracks to propagate these settings.

What may be more of a mystery at this stage however is the ‘Sync at’ value. This
aspect of a track as well as the Learn capabilities of EZplayer pro will be the subject

of a later chapter, but to finish off on the subject of Track properties let’s take a closer
look at the other settings located under the submenu of the same name, Auto-Rewind,
Loop, and Stop at release.

‘Auto Rewind’, applied by default, ensures that the playhead for this track returns to

the beginning of the sequence once the end of track has been reached. If you would
also like the track to continue playing from that point on, select ‘Loop’ and the entire
track will loop continuously until stopped.

‘Stop at release’ is more of a live performance control but in essence it lets you
playback a track for as long as the key it is mapped to is pressed down (see next
chapter for details on how to map tracks to a hardware controller).

[Ties] Besides Track properties, you can also copy the clips and accents (referred to
more generically as ‘Contents’) from one track to one or more target tracks,
independently from the track settings or together with them.

Track looping (‘Loop’) and user-defined loop locators are obviously mutually exclusive.
Dragging across in the timeline will take the track off looping mode.

EZplayer
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9. Performing Live
5.1 Syncing tracks to play in time

EZplayer pro was designed from the ground up to be performer friendly. It will
therefore come as no surprise that we have included some powerful features allowing
you to trigger your tracks as and when required in the most convenient possible way.

The first of such features is the ‘Sync at’ track property mentioned in the previous chapter.
Essentially this function ensures that your tracks always sync properly so that no
matter when you trigger a track all of the parts play in time.

By setting the ‘sync to tracks at’ value to the desired bar division value it allows you
to play your tracks without worrying about the exact timing of your performance to a
degree, leaving you free to create interesting layering that remains musical.

Should you prefer however, you can disable this feature by selecting ‘lmmediate’ as a
value.You will notice that EZplayer pro won’t thereafter force playback of your tracks
in sync, but will instead play the track to your desired timing. Varying the ‘sync at’
values on different tracks can offer you multiple creative possibilities when assembling
your music, so feel free to experiment.

5.2 MIDI learn

Another revolutionary feature of EZplayer pro is the ability to trigger and control
sequences live from a MIDI hardware controller.

Mapping your tracks to such a controller is called “MIDI learning” and is quite
straightforward: Simply choose ‘Learn Play Button’ from the Track Learn submenu as
shown below:

Track
Edit
Sync to Tracks at
Crid

Learn Play Button
Settings Learn Velocity Knob
Reset Assignments

Learn Master Play

Notice that the Play button turns green, indicating that you are ready to assign the
track to the MIDI controller. Press a key on your keyboard or controller pad.
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You can also assign the Track velocity knobs to any standard MIDI controller such as
a mod wheel, or specialist controller capable of sending continuous controller data
otherwise referred to as CC data (please refer to the MIDI implementation chart for
your hardware controller unit).

To do so repeat the procedure above choosing ‘Learn Velocity Knob’ from the track
menu. Move a knob on your MIDI controller and you're set: you can now remotely
control EZplayer pro from your MIDI keyboard.

[Ties] You can Auto-Assign up to the first |6 tracks of your arrangement with one
click. Check the ‘Auto-Assign Tracks to MIDI’ from the program’s main menu in the
top left corner of the interface. Once selected, your tracks will be assigned as follows:

Track | to note number | (C# -2), associated velocity controlled by CCOl (modulation
Track 2 to note number 2 (D -2), associated velocity controlled by CCO02 (breath ctrl)

and so forth.

5.3 Randomizing parts

Now let’s turn our attention to one of the most exciting features EZplayer pro has to
offer: user-defined layer playback or total randomization of parts.

Using the ‘Layer Handling’ track property,

you can build varifltion inlyour tracI.<S and v Play All
surprise your audience with no tedious Step Through
programming on your part: Random

* ‘Play AIl’ is the default and will playback all layers the same time.

* ‘Step Through’ will play through each layer sequentially with each pass soloing the

next one in the order they have been laid out in.
* ‘Random’ is exactly what you'd expect: even you won’t know what's next!

This feature can be invaluable on a track where you want variable fills inserted here
and there as transition between parts of your song, or complete megalomaniacal solo

drum parts to interact with another instrument.

[Tirs] Combining features like the previously mentioned “Sync at” with ‘Random’ layer

handling and live triggering can offer you endless possibilities. '
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6. Managing your library
6.1 Importing MIDI files

We have already described the procedure to add new MIDI files to your library by
dragging and dropping from the Finder / Windows Explorer or ‘Add Path’ menu entry.

In this section, we would like to offer further detail of the various mount point
properties that can be specified to better identify the MIDI being added to EZplayer pro:

ADD DIRECTORY TO THE HIDI BROWSER

Adolumes/SAMPLES/Library

Hame | Library

e e T " N
source movoios

Kit pieces

* ‘Instrument type’ allows you to categorize your MIDI files. Currently, it specifically
allows you to distinguish between drums, percussion and melodic material.

* ‘Source mapping’ is by far the most important mount point property as it ensures
EZplayer pro plays the right sounds. You should make sure it matches the internal
format of the MIDI files, typically identified by the sampler they were programmed for.
If in doubt,‘GM Drums’ under ‘General MIDI’ should in most cases yield correct results.

« ‘Kit pieces’ definitions are what allow EZplayer pro to extract kit pieces from grooves.
In most cases you will not be allowed to change the default selection except where
a format specific to Toontrack Music’s own line of samplers has been selected.

* ‘Hihat CC’ is only relevant for Drum grooves and will be taken advantage of by
EZplayer pro where appropriate. CC04 should be chosen in most cases.

[Ties] It is worth noting that some host applications will also allow you to drag MIDI
sequences directly from their arrangement page and tracks to the EZplayer pros Browser.

Remember that you can edit mount point properties at any point by Right ¢ clicking /
Control M€ clicking it.
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6.2 Exporting MIDI files

EZplayer pro allows you to export MIDI files in a number of ways. You already know
that you can drag and drop files from the Browser directly into your host, but the
same applies to any selection made in the Arranger.

Here is an overview of the various export possibilities at a glance:

* Drag a groove from the Browser into your host

* Drag a groove from the Browser to your desktop

* “Rubber band” select clips on a track and drag into your host

* “Rubber band” select clips on a track and drag to your desktop

* “Rubber band” select clips on a track and drag back into the EZplayer’s Browser
* Fuse several tracks into a single part to export using any of the above

This last facility requires explaining. You might have noticed that every track has a
Record button . By engaging it on a track you are in effect arming the track and
setting it as target for the recording.

The Record button controlling the Arranger as a whole is located at the bottom of the
interface and this lets you record MIDI input on the track or tracks armed previously.
Simply activate Record, and start playback in either the Browser or the Arranger.

Once you've assembled the perfect take you can save it back into the Browser or into
your host as a consolidated performance.

[Ties] The data recorded on the tracks includes currently playing tracks as well as live
stream from the host sequencer. This means that while the recording is in progress,
you can action the velocity knob on the tracks to record dynamic changes, from the
EZplayer pro interface or using a pre-configured hardware controller!

EZplayer
25



Anpendix
A- Setting up Ableton Live

EZplayer requires Ableton Live version 5 or later (previous versions do not support
key functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Open the Live Plug-in Device Browser
* Drag the EZplayer to a MIDI track or the Device Drop area

2) Setting up:

* Create a MIDI track with YFDS instantiated on

* Set its ‘MIDI from’ Input type to the MIDI track where you have dropped EZplayer
* Set the Input channel to ‘EZplayer

* Record-arm the MIDI track with YFDS

* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track with YFDS in the Arrangement View or Clip Slot
* Add additional grooves from EZplayer to create your new drum track
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B- Setting up Apple GarageBand

EZplayer requires GarageBand version 3 or later (previous versions do not support
key functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Insert the EZplayer plugin as an ‘Instrument Generator’ on a track

2) Setting up:

* Create a Software Instrument Track with YFDS instantiated on

* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

* Record-arm the Instrument Track YFDS is inserted on by clicking on it

3) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file to the

Instrument Track with YFDS on
* Add additional grooves from EZplayer to create your new drum track
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C- Setting up Apple Logic

EZplayer requires Logic version 7 or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Insert EZplayer on an Audio Instrument track
2) Setting up:

* Insert YFDS on an Audio Instrument track

At this point you will be able to drive YFDS with EZplayer but you will also trigger
any MIDI instrument that you happen to record-arm. You therefore need to perform
the following for additional flexibility:

* Open the Logic Environment

* Copy paste YFDS Instrument track to the ‘Click and Ports’ layer

» Still in the ‘Click and Ports’ layer, create a ‘Channel Splitter’ object

* Connect the EZplayer entry of the ‘Physical Input’ to the Channel Splitter

* Connect Ch10 of the ‘Channel Splitter’ to the Instrument track with YFDS on
(the other channels can be used for additional sound sources you wish to drive)

then

* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Set the channel Map Wrap ‘MIDI Redirect’ to channel 10

* Select a groove in EZplayer and press Play

3) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file to the

Instrument track with YFDS in the Arrangement Window
* Add additional grooves from EZplayer to create your new drum track
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D- Setting up Cakewalk Sonar

EZplayer requires Sonar version 5 or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Open the Synth Rack and insert EZplayer as aVST
* Make sure you select the ‘First Synth Output’ option
* Still in the Property box enable MIDI Output

2) Setting up:

* Insert YFDS, complete with Audio Outputs and Source MIDI track
* Set the Input of the MIDI track assigned to YFDS to EZplayer

* Ensure that Input Echo Monitoring is enabled as appropriate

* In EZplayer, choose the appropriate MIDI Output format for YFDS
* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track with YFDS in the Arrangement View
* Add additional grooves from EZplayer to create your new drum track
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E- Setting up Cockos Reaper

EZplayer requires Reaper version 2.2 or later (previous versions do not support
key functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Configuring Reaper:

* Go to Reaper’s Options > Preferences > Audio > Playback tab and make sure that
‘Run FX when stopped’ is enabled.

2) Inserting the plugins:

* Open the Reaper’s FX Browser (click on Track FX icon).

* Click on VSTi tab and drag the EZplayer plugin to the track FX icon.

* Drag YFDS to the same track FX icon (it should always be after EZplayer in the FX chain)
3) Setting up:

* In EZplayer, choose the appropriate MIDI Output format for YFDS
* Select a groove in EZplayer and press Play

4) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file to the
EZplayer/YFDS track in Reaper

* Click and drag either edge of your new MIDI clip to create a repeatable loop

* Add additional grooves from EZplayer to create your new drum track
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F- Setting up Digidesign ProTools

EZplayer requires Pro Tools version 7.3 or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in Pro Tools and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:
* Insert the EZplayer plugin on a Mono Instrument Track
2) Setting up:

* Create an Instrument Track with YFDS instantiated on

* Enable the ‘Instruments’ section view (lower left corner of the mixer window)

* At the top of the Pro Tools mixer, access the MIDI I/O for the Instrument Tracks
* Set the MIDI Input of your YFDS Instrument Track to ‘EZplayer

* Record-arm the Instrument Track YFDS is inserted on

* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

Instrument Track with YFDS on in the ProTools Edit window
* Add additional grooves from EZplayer to create your new drum track
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G- Setting up Image-Line Fruity Loops

EZplayer requires Fruity Loops version 5 or later (previous versions do not support
key functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:
* Go to "CHANNELS’,’Add one...” and select EZplayer in the list
2) Setting up:

* Go to "CHANNELS’,”’Add one...” and select YFDS in the list

* Make sure the 'Show MIDI input port’ is selected in the plugin window menu

* Set the port number in the upper right corner of the YFDS plugin window to e.g.’ 10’

* In the EZplayer plugin window, make sure the 'Show MIDI output port’ is selected
and set the output port to the same port number as YFDS

* In EZplayer choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

3) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file onto the
YFDS Channel, click ‘OK’ and it will be imported to the selected Pattern

* To add additional grooves from EZplayer, select a new empty Pattern in the Playlist
and repeat the procedure
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H- Setting up Mackie Traktion

EZplayer requires Traktion version 2 or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:
s insert EZplayer as a filter on a new track
2) Setting up:
* Insert YFDS as a new filter on a separate track
* Select the EZplayer track and change its properties so the
destination output is the track where you inserted YFDS
* In EZplayer, choose the appropriate MIDI Output format for YFDS
* Select a groove in EZplayer and press Play
3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track with YFDS in the Arrangement View
* Add additional grooves from EZplayer to create your new drum track
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I- Setting up Magix Samplitude

EZplayer requires Samplitude version 8 or later (previous versions do not support key

functionality necessary for operation).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Add EZplayer as a ‘Multi-Channel’ VSTi capble of sending MIDI
* In the plugin window, select the ‘MIDI Out’ option from the Plugin menu

2) Setting up:

* Add YFDS as aVSTi to the project

* Add a MIDI track to the project

* In the MIDI options for the track, choose VST MIDI Out - recording’
* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track with YFDS in your Arrangement
* Add additional grooves from EZplayer to create your new drum track
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J- Setting up MOTU Digital Performer

EZplayer requires Digital Performer version 4.6 or later (previous versions do not
support key functionality necessary for operation).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:
* Add an Instrument track with EZplayer instantiated on to the Project
2) Setting up:

* Add an Instrument track with YFDS instantiated on to the project
* Add a MIDI track to the project

* Set the Output of the MIDI track to YFDS

* Record-arm the MIDI track with YFDS

* In EZplayer, choose the appropriate MIDI Output format for YFDS
* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track with YFDS in your Arrangement
* Add additional grooves from EZplayer to create your new drum track
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K- Setting up Sony Acid

EZplayer requires Sony Acid 6 or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* In the Acid Mixer choose ‘Insert Soft Synth’
* Choose EZplayer in the list

2) Setting up:

* Insert YFDS in the project as described above

* Create a MIDI track and set the Output to YFDS

* Set the Input of this MIDI track to EZplayer

* In EZplayer, choose the appropriate MIDI Output format for YFDS
* Select a groove in EZplayer and press Play

3) Building a drum track:
* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track assigned to YFDS in your Arrangement
* Add additional grooves from EZplayer to create your new drum track
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L- Setting up Steinberg Cubase/Nuendo

EZplayer requires Cubase SX2 / Nuendo 2 or later (previous versions do not support
key functionality necessary for operations).

Before you start, you should make sure that you are familiar with how to operate
Virtual Instruments in your host and that you have a copy of YFDS (Your Favourite
Drum Sampler) configured for Audio and MIDI playback.

1) Inserting the plugin:

* Open Devices >VST Instruments and insert EZplayer

2) Setting up:

* Insert YFDS in the project as described above

* Create a MIDI track and set the Output to YFDS

* Set the Input of this MIDI track to EZplayer

* In EZplayer, choose the appropriate MIDI Output format for YFDS

* Select a groove in EZplayer and press Play

3) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file to the

MIDI track assigned to YFDS in your Arrangement
* Add additional grooves from EZplayer to create your new drum track
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M- Setting up Toontrack solo

EZplayer requires Toontrack solo I.I or later (previous versions do not support key
functionality necessary for operations).

Before you start, you should make sure that you are familiar with basic operation of
Toontrack solo and that you have a copy of EZdrummer or Superior installed and
configured for Audio and MIDI playback.

1) Inserting the plugin:

* Application menu > EZplayer > Open EZplayer

2) Setting up:

* Add a Drummer to the project using Add > Add Drummer

* Select MIDI > MIDI channel for this Drummer

* In EZplayer, choose the appropriate MIDI Output wrapper and channel

* Select a groove in EZplayer and press Play

3) Building a drum track:

* Once you have found the right groove, simply drag and drop the MIDI file to the

Arranger section
* Add additional grooves from EZplayer to create your new drum track
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Notes correspondence

Drums Percussions

Kick 36 (Cl) High Bongo 60 (C3)
Sidestick 37 Low Bongo 6l
Snare 38 Conga muted* 62
Handclap* 39 High Conga 63
Rimshot* 40 Low Conga 64
Low Floortom 41 High Timbale 65
Closed Hats 42 Low Timbale 66
High Floortom 43 High Agogo* 67
Hats Pedal 44 Low Agogo* 68
Low Racktom 45 Small Shaker 69
Open Hats 46 Big Shaker 70
Mid Racktom 47 Short Whistle* 71
High Racktom 48 (C2) Long Whistle* 72
Crash A (left) 49 Short Guiro 73
Concert Tom* 50 Long Guiro 74
Ride Cymbal 51 Claves* 75
Chinese Cymbal 52 High Woodblock 76
Ride Bell 53 Low Woodblock 77
Crash A muted* 54 Udu/Cuica muted* 78 (C4)
Splash Cymbal 55 Cuica/Udu 79
Cowbell* 56 Triangle muted 80
Crash B (right) 57 Triangle 8l

Crash B muted 58
Ride Crashed* 59

* Access to these specialist instruments is subject to availability in your sound source.
Other sounds may be produced at the corresponding note number.
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